CMBU00002462; RATLC00604588; permissions problem building over winked-in derived object

When your build script builds over a target without first removing it, the script must retain the permissions of the built-over DO. Your view maintains these permissions correctly, but the data container created by the MVFS gets new, potentially different permissions. As a result, subsequent attempts to build over the target may fail. 

CMBU00020733; RATLC605213; cannot copy contents of read-only folder to MVFS 

You cannot copy a read-only folder to the MVFS. After copying the read-only folder into the MVFS, it is protected against changes and the subsequent copying of any files or subfolders into it fails. 

Workaround: There are two possible workarounds to this problem: 

· Remove the read-only attribute from any folders to be copied into the MVFS before copying them. 

· After making the target directory in the MVFS, run the command 

cleartool protect –chmod +w dir-name 

where dir-name is the name of the target directory. This command makes the target directory writable before attempting to copy files into it. 

CMBU00022280; RATLC00605353; problems switching from no-automounting to automounting

If you change the setting of the Enable automatic mounting of NFS storage directories option in the ClearCase Control Panel after starting any remote NFS views or mounting any remote NFS VOBs, you must shut down and restart your computer. Otherwise, accessing MVFS files on remote NFS storage directories will produce incorrect function errors and opensendirp error messages in the MVFS logs. 

CMBU00026201; RATLC00605713; global types: differences in command line behavior and GUI behavior 

The ClearCase Type Explorer and Properties Browser always display information about local copies of global types, instead of displaying information about the global type.

If the client VOB you are browsing does not contain a local copy of a global type, the ClearCase Type Explorer does not display the global type.

CMBU00028068; RATLC00605895; diffbl does not work with imported baselines 

The cleartool diffbl command, which compares two baselines and shows the differences between them, does not work correctly when one or both of the baselines are imported baselines.

CMBU00028372; RATLC00605919; removal of branch may result in errors in snapshot view 

If a branch is removed from within a snapshot view, any loaded elements from that branch should remain in the snapshot view. However, when trying to list such an element, the program displays the error

cleartool: Error: Pathname is not within a VOB

The error is generated when attempting to list an element if the branched version of the element was previously selected by the snapshot view, but the branch has since been removed. Note that the element still exists in the VOB and the view, but cannot be listed by cleartool ls. 

CMBU00029594; RATLC00606007; integration stream property sheets may not show delivered activities

In the Project Explorer, the Activities tab of the baseline and integration stream property sheets does not list the activities that have been delivered to the integration stream and incorporated into the baseline. The Activities tab displays only activities that were created in the integration stream, including integration activities, which ClearCase generates during deliver operations.

CMBU00031803; RATLC00606182; predefined attribute not displayed on property sheet

The cleartool describe command lists predefined attributes for some objects. This output is likely to change in a future release. Specifically, settings that represent UCM information are likely to be removed or replaced with a more abstract representation. 

CMBU00032286; RATLC00606217; certain file names cause problems in snapshot view 

Files with names such as AUX.ext, CON.ext, PRN.ext, or NUL.ext, where ext is any file extension, can be loaded into a snapshot view, but cannot be unloaded from the view or deleted from the system. This makes it impossible to delete parent directories of such files as well. We recommend that you avoid using files names that are identical to the names assigned to basic system elements. 

Workaround: Enter the command, del \\?\drive:path
CMBU00032384; RATLC00606222; Print to File option does not work

The Print to file option of applications such as Microsoft Word does not work for an MVFS file. Attempting to print to file within the MVFS may result in the error access denied or the application may appear to hang as it continues to try to write the file. The problem is that the mechanism used for this function uses an identity that does not have the proper credentials for the MVFS to be able to validate it. The workaround is to print the file to a file outside the MVFS (such as a local or network drive) and then copy it into the MVFS from there.

CMBU00032695; RATLC00585647; opening multiple `nested' ClearQuest forms may cause crash 

The UCM-ClearQuest integration does not prevent you from opening a ClearQuest form, then going to the form's UnifiedChangeManagement page, using the shortcut menu in the change set to open a ClearCase dialog box, and selecting Activity Properties, which opens a second ClearQuest form.

However, if you follow this sequence of steps, the second ClearQuest form does not function correctly. In particular: 

· The Apply, Revert, and Cancel buttons on the form have no text. 

· If you attempt to go to the form's UnifiedChangeManagement page, and then close the form, you get this error: 

Unable to load message ID 14090 from resources

After displaying this error, ClearCase crashes. 

Therefore, we recommend that you not use this procedure to open a second ClearQuest form. 

CMBU00033224; RATLC00606313; ClearCase may not recover from Windows 2000 Hibernate mode 

Windows 2000 includes a Hibernate feature that allows the state of the current running system to be saved and restored quickly later on. Active ClearCase processes, as well as processes that have the ClearCase Network Provider loaded, may have TCP connections to servers on remote machines; such connections are likely to be closed by the servers while the system is in Hibernate mode. Therefore, the ClearCase client applications are likely to return errors when a user attempts to use them after the computer has been brought back from Hibernate mode. 

CMBU00033367; RATLC00585669; delivery of selected activity does not detect directory dependency across activities

If you create a new element in one activity (for example, A) while the directory containing the element is checked out to a different activity (for example, B), you have created an implicit dependency of A on B. When selectively delivering activity A, you must also include activity B. Otherwise deliver reports the error: DBID not found.

CMBU00033922; RATLC00585710; Merge Manager displays duplicate dynamic views in list 

Occasionally, when merging a file with Merge Manager, the combo box that indicates the view to be merged from displays two instances of each available dynamic view. In this situation, you can click either dynamic view to select it. The symptom is not known to cause any problems. 

CMBU00034354; RATLC00606436; no reporting of ClearQuest script error text 

Using the UCM-ClearQuest integration, you can customize the Check Before Deliver ClearQuest Visual Basic policy script. However, if the script as customized contains an error that causes the Visual Basic interpreter to display an error exception, the Deliver dialog box reports this error like this:

An error occurred during the deliver.

Unexpected error in deliver.

It does not report the actual error exception text which would enable the user to diagnose the problem script 

Workaround: To see the error exception text, use the cleartool deliver command.

CMBU00034355 RATLC00606437; must kill ClearQuest server to see schema upgrade 

Using the UCM-ClearQuest integration, if you upgrade a ClearQuest user database to a new schema revision, to see the change on a client machine which was connected to that user database, you must do the following on the client machine:

On Windows NT or Windows 2000
1. Open the Task Manager and go to the Processes tab. 

2. From the list, select CQINTS~2.EXE or CQINTSVR11.EXE. 

3. Click End Process 

CMBU00034481; RATLC00606443; changes to UCMCustomQuery1 do not appear in dialog box

When using the UCM/ClearQuest integration, the list of records on the list in the Add To Source, Check Out and Check In dialog boxes is generated by running the UCMCustomQuery1 query, which can be customized. (Note that to see the effect of your changes, you must click File > Save to save the query edits.) 

However, if you copied the Public Queries UCMCustomQuery1 query into your Personal Queries folder and edited it there, the changes are not immediately seen. To see your changes, you must stop the integration server process: 

On Windows NT or Windows 2000
1. Open the Task Manager and go to the Processes tab. 

2. From the list, select CQINTS~2.EXE or CQINTSVR11.EXE 

3. Click End Process.

After stopping the process on your computer, open the dialog box again. Further edits to /PersonalQueries/UCMCustomQuery1 appear without your having to shut down the process again. 

CMBU00034719; RATLC00606479; Refresh button may vanish in ClearCase Administration Console

When you display a view-private file in the ClearCase Administrator or Host Console, resizing its column headers or displaying the shortcut menu causes the Refresh toolbar button to be hidden. If this happens, you can access the Refresh command on the Action menu, or on the shortcut menu from the view-private file. 

CMBU00034976; RATLC00606520; using Browse button in Share dialog hangs Visual Basic integration

When using the ClearCase integration with Microsoft Visual Basic, do not use the Browse button in the Share dialog box, which may cause the application to hang. Instead, either supply a complete path to the Share dialog box using the Edit box or avoid using the dialog box. 

CMBU00034809; RATLC00606497; externally removed view still appears as Web interface session

If a user's Web view is deleted from outside the Web interface (for example, with a cleartool rmview command on the Web server), it no longer appears in the Select View page of the Web interface, even though the corresponding view location area on the client may still exist. There is no indication that the server component of the view disappeared.

CMBU00043178; RATLC00606976; using Web interface with Netscape causes harmless error messages 

Web clients that use Netscape Navigator may see an error message similar to the following in the Web server logs:

File does not exist: /usr/atria/web/applets/com/ms/security/PermissionID.class

File does not exist: /usr/atria/web/applets/com/ms/security/PolicyEngine.class  

These error messages are harmless and can be ignored.

CMBU00054897; RATLC00587184; files are rendered as double-spaced after removing carriage return markers

On Windows 2000, if the Diff Merge tool is set to show the carriage return markers on the display and those markers are turned off, the resulting display is double-spaced. This problem can be corrected by clicking Edit > Restart Comparison. The application will start normally on the next invocation.

CMBU00054904; RATLC00607581; Add View Shortcut dialog stalls when diskette drive is offline

The Add View Shortcut dialog box may appear to hang if the diskette drive is disconnected, as it may be on a laptop. This dialog box contains a drive letter combo box that should list available drive letters, as well as the drive letter that may be already connected to the view that you chose. If a diskette drive is disconnected, it may take 10 or 15 seconds to time out. During this time, the application is inaccessible.

CMBU00055887; RATLC00607521; when using Web interface, merge from a dynamic view fails when performed on a file checked out to the source view

When using a dynamic view as a merge source in the ClearCase Web interface, any elements that are checked out in that view (and need merging) cause an error during the merge. The elements should be checked in (or their checkouts cancelled, as appropriate) in the source view before merging.

CMBU00057114; RATLC00607739; interoperability issues running UNIX Web server and Windows ClearCase Web client

When entering a version identifier as an advanced version selector in the Welcome to Merge Manager page, you must use forward slashes (/) if the Web server is running on UNIX. If the Web server is running on Windows, you may use either / or \.

CMBU00057568; RATLC00607814; creating symlink to VOB root from child directory works but produces spurious messages

On Windows NT, creating a symbolic link to the VOB root from a child directory works correctly but produces spurious error and warning messages:

cleartool: Error: Symbolic Link cycle detected for 
"vobname\child_directory\vobroot". 

cleartool: Error: Errors were encountered in loading 
"\vobname\child_directory\vobroot". 

cleartool: Warning: Trouble updating name "vobroot" in snapshot view: 
error detected by ClearCase subsystem.  

The output of the command indicates that the link is successfully created and is correct.

CMBU00057643; RATLC00607833; when using XML Diff Merge, 'Show All Diffs' and 'Show All Conflicts' blank the Web browser pane

When using the XML Diff Merge tool, if the Web browser pane is visible, and you click either Show All Diffs or Show All Conflicts, the Web browser display goes blank. The Web browser pane should be unaffected. 

Workaround: Click one of the contributor panes to refresh the Web pane.

CMBU00057758; RATLC00607874; XML Diff Merge does not support UTF-8 Byte-Order Mark 

Some applications, for example Windows Notepad on Windows 2000, may include a Byte Order Mark (BOM) when directed to save results encoded as UTF-8. If the first three bytes of an XML file are { EF BB BF } (hex), the file is UTF-8 and the 3-byte sequence is the BOM. While a BOM is mandatory for UTF-16 files, it is optional for UTF-8 files. 

The XML parser used by XML Diff Merge does not recognize the UTF-8 BOM, and instead reports a syntax error. To compare or merge such files with XML Diff Merge, one of the following workarounds may be used: 

· Remove the BOM (first three bytes) from the files. The files will then parse and load as UTF-8. 

· Compare or merge using the text Diff Merge tool. 

· Convert the XML data to another encoding, for example, UTF-16 (in which the BOM is recognized) or ISO-8859-1 (for which it is not used). 

RATLC00236727; installer should disallow custom install directories with nonstandard characters

The install program does not verify that the installation destination directory is a valid Windows directory. If an invalid directory name is entered, the install may complete, but the installed product is not likely work correctly.

RATLC00236978; cannot run setup from folder containing double-byte characters

Release area pathnames should not contain multibyte characters.

RATLC00237861; Site Preparation Tool does not support keyboard accelerators

In the Site Preparation Tool, you must always use the mouse to click the Next and Back buttons. Alternatively, you may go to specific pages by clicking the list control. The Site Preparation Tool does not support the use of keyboard accelerator keys. Alt+N is not equivalent to the Next button, and Alt+B is not equivalent to Back. If you use these key sequences, Site Preparation Tool will advance to the next "dialog resource" instead of the next "page," and this results in an incorrect display. If you type Alt+N (Next) inadvertantly, you can type Alt+B (Back) to go back to the original page. No damage or corruption will occur if you do this and you can proceed with the install.

RATLC00434880; Refactor/Rename does not work correctly for a versioned package

When WebSphere Studio refactors Java package names that are under ClearCase control, it does not rename the package directory, but instead deletes the old location and creates new files in the new location. Consequently, the version history of the Java package is lost. In addition, you are prompted to add the package to source control.

RATLC00435320; redundant welcome screen during startup

There is an extra welcome screen during startup.

RATLC00442124 rebase fails because hyperlinks cannot be removed

If a rebase operation fails with the message No permission to perform operation “remove hyperlink” and you are using a replicated VOB, the baseline hyperlinks associated with your current stream may not be mastered by your current replica. The failure occurs because the chmaster –stream command does not change mastership for baseline hyperlinks associated with that stream. 

Workaround: Use cleartool describe to find the hyperlinks, and then use chmaster to change their mastership to the appropriate replica. For example:

cleartool describe —l stream:devA_stream@/vobs/pvob ... Hyperlinks: UseBaseline@19@/vobs/pvob —> baseline:baselineA@/vobs/pvob Guarding: brtype:devA_stream@/vobs/pvob

multitool chmaster siteB@/vobs/pvob hlink:UseBaseline@19@/vobs/pvob

RATLC00442571; spurious region-checking error

CC Doctor sometimes reports a spurious region-checking failure with the message, Nonexistent ClearCase Region or Regions: Region " " unknown ... Ignore the error. To confirm the existence of region, use the lsregion command.

RATLC00443077; pbimport limitation

In the integration with PowerBuilder versions 6, 7, and 8, importing PBLs sometimes fails. The workaround is to use third-party solutions or upgrade to PowerBuilder version 9. PowerBuilder 9 can determine whether PBLs need to be changed, and the PowerBuilder 9 integration does not require versioning PBLs. Instead, you can write Orca Utility scripts to rebuild targets.

RATLC00443987; data code page errors

You may see an error message about data code pages if you use the ClearCase–ClearQuest integration. The error message appears when you enter data into ClearCase using characters that are incompatible with the set of characters that a ClearQuest database accepts. If you see such error messages, consult with your ClearQuest administrator or systems administrator to resolve the character set incompatibility.

RATLC00446526; ClearCase install prompts for ClearCase LT configuration information

When installing a Suite with the optional ClearQuest Shipping Server feature enabled, ClearCase LT is disabled because it conflicts with this ClearCase feature. In this case, the Site Preparation Tool—or, if you are installing the software, the configuration screens—incorrectly requires you to specify a name for the ClearCase LT server. As a workaround, type any string as the name of the server. The server name will be ignored because ClearCase LT will not be installed in any case.

RATLC00045723, XDE 1.0/1.1 will not run with version 2003.06.00

XDE versions 2002.05.20 and earlier do not operate correctly when ClearCase starts a merge operation. The merge operation attempts to call the XDE type manager, which fails. To avoid the problem, we recommend upgrading to a newer version of XDE but if that is not possible, use the following procedure to correct the problem:

1. Close XDE and ClearCase applications. 

2. In a text editor, open the file cc_install_dir\ClearCase\lib\mgrs\map. 

3. Replace all _xde entries with following entries, which can be found in the file xde_install_dir\XDE\Addins\CompareMerge\cc_xde_unit.map.

_xde
construct_version

..\..\bin\bdtm.exe

_xde
create_branch

..\..\bin\bdtm.exe

_xde
create_element

..\..\bin\bdtm.exe

_xde
create_version

..\..\bin\bdtm.exe

_xde
delete_branches_versions

..\..\bin\bdtm.exe

_xde
compare

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\XDE\TypeManager

_xde
xcompare

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\XDE\TypeManager

_xde
merge

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\XDE\TypeManager

_xde
xmerge

HKEY_LOCAL_MACHINE\SOFTWARE\Rational Software\XDE\TypeManager

_xde
annotate

..\..\bin\bdtm.exe

_xde
get_cont_info

..\..\bin\bdtm.exe

RATLC00510248; VS.NET Solution Explorer does not indicate which files are hijacked

The VS.NET Solution Explorer displays a hijacked file with the lock icon, indicating that the file is under version control, but gives no indication that the file is hijacked. To verify the state of an element, use ClearCase to check its properties.

RATLC00584804; real attribute type does not work correctly in interop environment

The attribute type real does not work correctly in an environment of both UNIX and Windows systems. In such environments, VOBs may hold values that originate from both Windows and UNIX. Values orginating from UNIX systems appear incorrect to Windows clients, and those originating from Windows appear incorrect to UNIX clients.

RATLC00585713; cleartool checkin may fail in race condition

If two checkin operations are run simultaneously on an element and a branched sibling that share the same cleartext container, one of the checkin operations may fail. To correct the problem, perform the checkin again.

RATLC00586465; problem with cleartool when space in element names

When run in interactive mode, cleartool does not handle element names correctly if they contain embedded spaces.

RATLC00588382; delivery of one baseline is difficult to do

To deliver a single baseline, the deliver operation GUI requires you to select each baseline that is not to be delivered and click Remove. There is no workaround.

RATLC00607883; cannot check in multiple versions of a change set at the same time

On the Change Set tab of an activity's propert sheet, you cannot check in or cancel checkins of multiple versions of the change set at the same time; you can only checkin one version or cancel the checkin of one version at a time. However, you can right-click the activity in the Project Explorer and select Checkin All from its shortcut menu to check in all versions associated with the activity.

RATLC00683518; problem with linking activities mastered at remote site

Using a UCM project that is enabled for ClearQuest may leave activities that are mastered at remote sites unlinked to the ClearQuest database. To link the unlinked activities, use the following procedure:

1. Change the mastership of the UCM Project object to the remote site. 

2. At the remote site, open the Project Properties page, select the ClearQuest tab, and click Link unlinked activities mastered at this replica.

Conversely, disabling a UCM project from ClearQuest may leave activities that are mastered at remote sites still linked to the ClearQuest database. To unlink the linked activities, use the following procedure:

1. Change the mastership of the UCM Project object to the remote site. 

2. At the remote site, open the Project Properties page, select the ClearQuest tab, and click Unlink all activities mastered at this replica.

RATLC00685704; design problem in Site Preparation Tool

On the MVFS Settings dialog, two fields labeled Maximum number of mnodes... are loaded based on the selection in the Scaling factor combo box. If you specify a nondefault value in either of these fields and then redisplay them, the value is overwritten by the default value. As a workaround, you can either use the default values or avoid displaying MVFS Settings after you have specified a nondefault value.

RATLC00685819; binary data inserted into text files that are modified using VS.NET

A problem has been detected storing text files in ClearCase under certain conditions. If you edit a new text file in VS.NET and check it in, the contents are stored normally. However, if you subsequently check out, modify, and check the file back in, binary data is inserted into the file. 

The problem has been detected in text files that were edited using the native VS.NET source code editor, and saved to a dynamic view. The systems on which the problem was detected used a remote dynamic view UNIX server running Samba 2.0.7 for interoperability. The problem has not been detected under the following conditions:

· Using snapshot views with remote view server on UNIX. 

· Using a local dynamic view server on Windows. 

· Using a remote dynamic view server on UNIX, running Disk Access for interoperability. 

· Saving files edited using a non-VS.NET editor (such as Notepad) to a dynamic view. 

· Using other Microsoft applications, such as MS Visual Studio 6.0 with remote dynamic view servers.

RATLC00686946; ClearCase–DDTS and ClearCase–FrameMaker integrations contain incorrect references to atria

The documentation for the ClearCase–DDTs and ClearCase–FrameMaker integrations contain incorrect references to the term atria.

RATLC687458; configuration tool sometimes appears under the MSI custom feature dialog

During a custom install on Windows .NET Enterprise Server RC2, the configuration window sometimes appears below the install window, which gives the impression that the installer is hung. The Configure application will appear in the task bar; click the icon to move the application to the foreground.

RATLC00687652; report on required disk space is unreliable

The required disk space reported by the install program is unreliable. For accurate information, see the Installation Guide for your product.

RATLC00687776; deleting ClearQuest record invokes debugger when UCM activity is set in a view

If you use the UCM-ClearQuest integration connected to a user database in Microsoft Access 2000, you may encounter an error when you remove an activity record using the native ClearQuest client. If the record is associated with an activity that is set in a view, a debugger window incorrectly opens for clearquest.exe. A message correctly states that the activity cannot be removed because it is set in a view.

To recover, close the debugger windows. To remove the activity record, use ClearCase to unset the activity in the view and retry the operation.

RATLC00688086; PERL5LIB, PERLLIB may confuse Perl

Setting the environment variables PERL5LIB or PERLLIB in the environment from which ClearCase processes are run may result in run-time errors having to do with the ClearCase Perl interpreter finding the wrong versions of Perl modules.

RATLC00688112; completion component only works once

You can create and edit multiple configuration documents during a single run of the Site Preparation Tool. The Completion component functions correctly on the first document; however, if you attempt to create or edit additional documents, the Completion component will be missing. As a workaround, work on only one document per invocation of the Site Preparation Tool.

RATLC00688533; attempt to create new document can cause crash

When focus is within an edit control, an attempt to creat a new document can result in a crash. To create a new document (using File > New or File > Open), ensure that the focus is not within an edit control by clicking elsewhere, for example, on a tree node or button.

RATLC00688491; single-stream project not recognized as such

If you use clearprojexp to create a single-stream project, the GUI does not recognize the project as a single-stream project until you either refresh the view or exit the GUI and restart it. Until you refresh the view or exit and restart the GUI, a user can create a child stream in the integration stream of the project. This problem only occurs in the application instance that created the single-stream project.

RATLC00689857; Java nature of WebSphere Application Developer 4 Java Project may be lost during import

If you copy a WebSphere Application Developer 4 Java Project from one VOB to another without adding the file to source control, and you then import the project into WebSphere Application Developer 5 by clicking the Import > Existing WebSphere Studio 4.x ClearCase Project into Workspace option in WebSphere Studio, the Java nature of the project is lost.

RATLC00689868; WTS install from remote shares can fail

When installing from a remote release area on a Windows 2000 server with the application-mode Windows Terminal Service enabled, the install may fail silently. This becomes apparent when UseDLL failures occur. The failures are logged in the file rational_install.log and you can search for them using the following command:

%windir%\system32\find.exe /i “fail” %TEMP%\rational_install.log
Such failures mean that the install failed. For example, ACLs on the installed directory may not be set. As a workaround, avoid installing the product in this manner.

RATLC00689959; problem comparing HTML files on Japanese systems

You cannot compare HTML files—for example, by using diff—if the install directory contains the character 5c in the trail byte. This problem affects Japanese language installations.

RATLC00690181; creds output no longer indicates if the CC primary group is invalid

The creds command does not issue a warning when a user is not a member of the domain group named by the user's CLEARCASE_PRIMARY_GROUP environment variable.

RATLC00690213; new JBuilder project contents are not ClearCase-enabled until Refresh Status is clicked

JBuilder project contents are not enabled for ClearCase after you click Add to Source Control. As a workaround, when you create a new resource in JBuilder, first save the resource and then click Refresh Status.

RATLC00690620; install log can be lost if the install is done through the admin mode WTS session

The install log that is written to the user's temp directory may be lost on WTS systems that remove that directory when the system is rebooted.

RATLC00691170; problem with line terminators in files read by Site Preparation Tool

There may be a problem when certain file and directory pathnames are read by the Site Preparation Tool. Some data fields may contain multiple lines of text. Each line is terminated with an EOL marker, which is <CR><NL> on Windows. For storage in the output site defaults file, these EOL markers are converted to the character sequence \n. If a pathname happens to contain the character sequence \n, it is converted to a Windows EOL marker. For example, a path like C:\one\new\thing.ini would be converted to C:\one<CR><NL>ew\thing.ini.

RATLC00691560; PVCS export fails if path includes 0x5c character

You cannot use the clearexport_pvcs command to export PVCS data from a path of which any component includes the Japanese character 0x5c. The PVCS commands required for export fail in this configuration. As a workaround, rename the file or directory that includes the 0x5c character.

RATLC00691673; ClearCase–VS.NET integration Help file does not display topic

In the ClearCase–VS.NET integration, you click Tools > Options to modify IDE settings. However, the Help button on the Options page fails to access its Help topic. The correct Help topic for this page, Rational ClearCase Options Window, is available in Help for the ClearCase Integration with VS.NET. You can access it from the topic, Setting Options for the ClearCase VS.NET Integration.

RATLC00692556; mkbl –activities can fail in mixed version configuration

The mkbl –activities operation, whether invoked as a command or through a GUI, fails in an environment in which the VOB server is running Version 2003.06.00, clients are running Version 2002.05.00 and Version 4, and the following scenario takes place:

1. A V4. client delivers work from a development stream to an integration stream. 

2. The feature level of the PVOB is raised to 4. 

3. A 2003.06.00 client invokes mkbl –activities on the integration stream.

As a workaround, use the mkbl operation without specifying activities in this situation. You can then use mkbl –activities, specifying new activities.

RATLC00692648; setup.exe unconditionally overrides CC Doctor Registration

CC Doctor may fail because of an incorrect registration after you cancel an install that is in progress. To rectify the situation, use regsvr32 to register ccdoc.dll manually in such cases.

RATLC00692699; ClearCase Explorer icon not removed from desktop during uninstall

The ClearCase Explorer icon persists after you uninstall the product. After completing the deinstall, you can remove the icon manually.

RATLC00692753; install can fail with InstallShield error

The install program sometimes fails with the error 1607: Unable to install InstallShield Scripting Runtime. Consult http://www.installshield.com for information about resolving this problem.

RATLC00693036; missing domain mappings for UNIX clients

The UNIX mapping domain in the ClearCase control panel is labeled "Use this domain to map UNIX user and group names." The installation of a ClearCase server may leave the UNIX mapping domain blank. The UNIX mapping domain is needed only for configurations that support UNIX snapshot views accessing Windows VOBs. If this item is needed for your configuration and is blank, you may receive error messages indicating that support for UNIX clients was disabled. To fix the problem, select an appropriate domain from the Options tab of the ClearCase control panel.

RATLC00693521; ClearCase, ClearQuest, and Rational Shipping Server Incompatibility

Rational recommends that you avoid configuring any one host to run the Rational Shipping Server for both ClearCase and ClearQuest, because de-installing either product from such a host will remove the Shipping Server that is used by both products and render the remaining product inoperable. If you must install both ClearCase MultiSite and ClearQuest with the Rational Shipping Server on the same host, ensure that you do the following: 

· Install ClearCase first 

· Uninstall both products if you ever uninstall either product 

Note: Administrators should be sure that site configuration files for typical host systems do not specify installation of the Rational Shipping Server. Any attempt to install ClearCase on a host where ClearQuest and the Rational Shipping Server is already installed will fail. 

RATLC00693851; command alias arguments fail for cleartool man HTML pages

When you specify a cleartool command alias such as ci and co as the argument to cleartool man, the command fails with an error like No such file or directory. As a workaround, use the full command name, such as checkin and checkout, as the argument.

RATLC00694024; license keys not initialized after deinstall of earlier release

License key information is not initialized when configuring a system after deinstalling an earlier release. To install without the keys, temporarily specify a license server while entering configuration information. After installing the software, enter the license keys in the ClearCase control panel. They are retained in the registry key HKLM\Software\Atria\ClearCase\CurrentVersion\LicenseKeys.

RATLC00694031; embedded spaces in path to release area

When there are spaces in the path to a release area, a shortcut created by the Site Preparation Tool to a site defaults file in that directory fails. To work around this problem, use one of the following methods:

· Use a release area name without embedded spaces. 

· If the release area already exists, enclose the paths in the shortcut property page with quotes. 

· Run the commands manually, thereby avoiding shortcuts.

RATLC00694228; EOL markers not protected in resolved merge regions

Merge operations can incorrectly allow EOL markers (newlines) in a resolved merge region to be deleted, which can result in data corruption. EOL deletion can occur in the following circumstances:

· The cursor is at the end of the line preceding the resolved merge region and you press DELETE. 

· The cursor is at the beginning of the resolved merge region and you press BACKSPACE. 

· The cursor is at the end of the resolved merge region and you press DELETE. 

· The cursor is at the beginning of the line following the resolved merge region and you press BACKSPACE.

If you inadvertantly delete a newline preceding or following the resolved region, restart the merge.

RTATLC00694382; problem synchronizing graphics and text in diff-merge GUI

In the diff-merge GUI, graphics in the left margin of the contributor that has focus sometimes become desynchronized with the corresponding text. To force the margin to be redrawn, scroll the contributor or move a pane splitter.

RATLC00694503; ClearCase Doctor and Server Storage Wizard not invoked after silent install

After rebooting a system on which you have run a silent install of the ClearCase server, ClearCase Doctor and the Server Storage Wizard are not invoked as they should be. As a workaround, invoke them manually.

RATLC00694793; albd_server can fail at transition to daylight saving time

On any host where the ClearCase scheduler runs a job on an hourly schedule, the albd_server will fail during the hour before the transition from standard time to daylight saving time . The failure will stop all ClearCase operations on the host. Note that the default set of scheduled jobs does not include any jobs that run hourly.

RATLC00694882; specifying both –blank_ignore and –graphical crashes diff-merge GUIs

If you specify -blank_ignore and -graphical when invoking a diff or merge operation from the command line, the GUI crashes. As a workaround, do not specify -blank_ignore on the command line. When the GUI is displayed, use the toolbar to specify that blanks are to be ignored.

RATLC00695292; Space button produces fatal error when you modify the installation of any product using the Rational Setup Wizard

If you are modifying the installation of any product available from the Rational Setup Wizard, a fatal error occurs when you click the Space button in the Custom Setup page. To prevent the Setup Wizard from failing, do not click the Space button.

